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TP 0 : Premiers Pas

Objectifs du TP. Prendre en main Python et Pyzo, se sensibiliser aux variables et expressions, écrire quelques
boucles. Ceux qui connaissent déjà Python ou ont déja quelques rudiments de programmation pourront répondre aux
questions facultatives en fin de TP. La dernière section est à faire à la maison pour le 17/09.

1 Prise en main de l’environnement
Aller dans votre répertoire personnel, et créer un répertoire Informatique. Dans celui-ci, créer un autre répertoire

TP0.

2 Ouverture et présentation de Pyzo
Ouvez Pyzo : Logiciels → PYTHON → Pyzo. Pyzo est l’environnement de développement dont nous allons nous

servir pendant l’année, pour travailler sur Python. Normalement, à l’ouverture de Pyzo, vous avez quelque chose qui
ressemble à la figure 1.

Figure 1: L’environnement de développement Pyzo

Il y a quatre parties distinctes :
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— la partie en haut est la console Python. On peut directement écrire du code Python dedans (au niveau du
In [...]), il est alors interprété immédiatement ;

— la partie en bas à gauche est l’éditeur : cette partie sert à rédiger des scripts Python plus complexes (ouvrez
une nouvelle page avec File > New si nécessaire). Une fois le script écrit on « l’envoie vers la console » (Run >
Execute File) ou CTRL + E, ou encore la touche F5.

— les deux parties à droite sont moins importantes. La première résume notamment les modules importés et les
fonctions déclarés, la seconde est simplement une exploration de votre répertoire personnel.

2.1 La console : quelques calculs
On se concentre ici sur la console Python. Positionnez-vous au niveau de la première fenêtre, qui est la console

Python, plus précisément au niveau du In[numeo de ligne], qui s’appelle le « prompt », ou « invite de commandes ».
Dans le texte qui suit, on le remplaçera par trois chevrons >>>. La console permet de lancer des commandes, immé-
diatement interprétés par Python. Commençons par le classique :

print("Hello World!")

que vous ferez suivre de la touche [ENTRÉE]. Lancez ensuite quelques calculs simples (suivis de la touche [ENTRÉE]),
comme ceux-ci

3+4 -5.5*6 3.0-4*5 13//4 13/4 13%4 5**3 (5+2)*(5-2)

En Python 3, // est la division entière (quotient dans une division euclidienne), % le modulo (le reste dans cette
division), et ** l’exponentiation (puissance). Ainsi, on peut utiliser la console comme une grosse calculette. On peut
également utiliser des variables : tapez les trois lignes suivantes, à chaque fois suivies de la touche [ENTRÉE].

>>> a=6+3
>>> b=a//2
>>> print(a+b)

Remarquez que = est utilisé pour affecter une valeur à une variable (l’équivalent du ← dans les algorithmes du
cours écrits en pseudo-code).

2.2 Enregistrement d’un script
Dirigez-vous maintenant vers la partie éditeur (qui doit être une page blanche, appelée <tmp 1>) ou ouvrez-en une

autre avec File > New File. Enregistrez la page sous le nom TP0_1.py, dans le sous-répertoire TP0 que l’on a créé tout
à l’heure.

2.3 Exécution d’un script
Écrire maintenant dans le fichier le code suivant (les espaces sont obtenus par une tabulation).

a=3
if a%2==0:

print("a est pair")
else:

print("a est impair")

Remarquer que Pyzo vous aide en plaçant pour vous les tabulations (on parle d’indentation automatique). Lorsque
vous vouler revenir en début de ligne (par exemple pour taper le else ou le print), utilisez simplement la touche de
retour chariot.

Sauvegardez votre code (CTRL+S ou File > Save à la souris), puis appuyez sur F5 ou faîtes Run > Execute File.
Débrouillez-vous maintenant pour faire subir à une variable b initialisée à 4 le même traitement que l’on a fait subir
à a (un copier-coller est tout indiqué !). Appuyez sur F5 et vérifiez le résultat dans la console.
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2.4 Les commentaires
Il est important, du point de vue de la réutilisabilité du code, de mettre des commentaires : un morceau de code

ayant une utilité tout à fait claire au moment où vous l’écrivez vous paraîtra beaucoup plus obscur dans plusieurs
mois. Cela peut aussi servir pour travailler à plusieurs sur un fichier. Les commentaires sont des morceaux de code
qui ne sont pas interprétés par Python, et sont destinés à l’humain seulement. Vous pouvez aussi commenter les codes
dont vous n’avez plus besoin, pour éviter par exemple d’avoir des affichages à l’écran qui ne sont plus utiles.

Il y a plusieurs manières de mettre un commentaire dans le code. Premièrement, sur une seule ligne, tout ce qui
suit le caractère dièse (#) est un commentaire. C’est ce qu’on peut utiliser par exemple pour expliquer ce que fait une
variable. Pour commenter plusieurs lignes, on peut mettre # en chaque début de ligne (sous Pyzo : sélectionner une
région, et faire Edit > Comment ou CTRL + R. Pour décommenter : CTRL + T). Une autre solution est d’utiliser
des chaînes de caractères pouvant s’écrire sur plusieurs lignes : mettre trois « quotes » (le caractère ") avant et après
la partie à commenter. Par exemple :

"""

Ceci est un commentaire, vous pouvez le taper et faire F5 pour tester.

"""

a=4 #Ce qui suit le # est aussi un commentaire. On affecte à a la valeur 4.

3 Les types simples
En Python, les objets ont des types, qui caractérisent les attributs de l’objet, ainsi que les fonctions que l’on

peut appliquer dessus. On appelle type simple l’un des types suivants : entier, flottant, booléen. Rappelez-vous que
type(valeur) donne le type de la valeur passée en argument.

3.1 Présentation des types simples
Tapez les lignes suivantes dans votre fichier TP0_1.py, et exécutez-les.

a=1
b=a/2
c=a<b
print(type(a))
print(type(b))
print(type(c))

On retrouve les types int (pour integer, entier en français), float (pour floating point number, nombre à virgule
flottante ou simplement flottant en français), bool (pour boolean, booléen). Si vous êtes choqués par la ligne c=a<b,
voici une explication : a<b est une comparaison entre a et b. Son résultat est soit vrai (True) soit faux (False), et le
résultat de cette comparaison est stocké dans c. Vous pouvez taper c dans la console pour vérifier sa valeur.

3.2 Opération sur les entiers/flottants
On donne ci-dessous la signification des opérateurs mathématiques élémentaires sur les entiers ou les flottants

(nombres à virgule arrondis).

opérateur + - * / // % **
signification addition soustraction multiplication division division entière modulo puissance

Remarquez que les entiers sont automatiquement convertis en flottants, si besoin.
La règle de priorité des opérateurs dans les expressions arithmétiques est la suivante : on commence par évaluer

les puissances, puis les modulos, ensuite les multiplications et divisions, et enfin les additions et soustractions. Pour
les cas d’égalité de priorités, les opérateurs les plus à gauche sont évalués en premier 1. Les parenthèses sont à votre
disposition pour changer l’ordre des priorités.

1. Sauf l’exponentitation : testez 2**2**3
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3.3 Booléens et opérateurs de comparaison
Les booléens ne prennent que deux valeurs : True et False. Ils sont utilisés essentiellement comme conditions : on

a par exemple utilisé une structure conditionnelle (if) tout à l’heure, testant l’égalité d’un entier avec 0. Suivant la
valeur du booléen, l’une ou l’autre partie du code était exécutée. Voici la liste des opérateurs de comparaison sur les
entiers/flottants :

< > <= >= == !=
strictement inférieur strictement supérieur inférieur ou égal supérieur ou égal égal différent

De même que l’on peut faire des opérations entre entiers et flottants, on peut faire des opérations entre booléens. Par
exemple, pour exprimer que l’entier n est strictement positif et inférieur ou égal à 100, on écrira : n>0 and n<=100 2.
Le tableau suivant présente les différents opérateurs booléens et leurs tables de vérité.

a b not a a or b a and b
False False

True
False False

False True True False
True False

False
True False

True True True True

L’ordre de priorité d’évaluation pour les opérations booléennes est not, puis and et enfin or. On peut également,
comme sur beaucoup d’objet Python, utiliser les opérateurs == et != pour l’égalité et la différence.

4 Importer un module (et voir l’aide)
Prenons deux opérations mathématiques classiques : la racine carrée et l’exponentielle. En Python, elles sont

données par sqrt (square root) et exp. Seulement, ces fonctions nécessitent d’être importées de la bibliothèque standard,
car elles ne se trouvent pas dans le noyau Python. Sans surprise, on les trouve dans un module appelé math. Deux
(quatre) solutions pour les importer :

— importer le module math avec la commande import math. On accède ensuite aux fonctions avec math.sqrt et
math.exp.

— une variante de la précédente : on peut utiliser un alias pour éviter de taper le nom du module en entier. Par
exemple, on importera le module sous le nom m, avec import math as m. On accède ensuite aux fonctions avec
m.sqrt et m.exp. C’est particulièrement utile lorsque les noms des modules sont longs.

— importer spécifiquement les fonctions sqrt et exp du module math, en tapant from math import sqrt,exp.
On accède aux fonctions simplement avec sqrt et exp.

— une variante de la précédente : importer toutes les fonctions du module math avec from math import *. Cette
solution est à éviter pour plusieurs modules : on risque d’avoir plusieurs fonctions avec le même nom. Cela dit,
on peut le faire sans problème avec un seul module, et le module math s’y prête bien.

Importations possibles des fonctions sqrt et exp
import math # puis utilisation de math.sqrt et math.exp
import math as m # puis utilisation de m.sqrt et m.exp
from math import sqrt,exp # puis utilisation de sqrt et exp
from math import * # puis utilisation de sqrt et exp

Il y a bien sûr d’autres fonctions usuelles dans le module math. Outre les fonctions trigonométriques et logarith-
miques qui ont les noms attendus, on trouve par exemple les définitions des constantes e et pi, qui s’importent de la
même façon. On verra quelques autres packages pendant l’année. Comme il y en a beaucoup, il est hors de question
de connaître tous ces packages et les fonctions qu’ils contiennent par coeur. Python propose une documentation très
détaillée à l’adresse : http://docs.python.org/3/.

2. On peut remarquer que Python comprend aussi très bien 0<n<=100...
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5 À vous de jouer !
Exercice 1. Type des expressions. Prévoir le type des expressions suivantes, et le résultat.

1. 2**3.0+4

2. 2>=3 or 2**4*5**2//20==20

3. True or 4>3 and 3>4

4. 5%3*5

5. not False and False

6. int(8.6)+2 Que fait int ?
7. float(2)**3 Que fait float ?

Exercice 2. Expressions booléennes. 1. Écrire des expressions booléennes exprimant le fait que les quantités qui
suivent sont positives. Vérifiez avec Python si elles s’évaluent en True ou False. N’oubliez pas d’importer ce
dont vous avez besoin du module math.

a.

√
1 +

√
1 +
√

1 + 1− 1 +
√

5

2

b.
√

3

2
− e

π
2. Donner une expressions booléenne dépendant des variables a, b, c et d exprimant le fait que a est supérieure ou

égale à b, c et d. Tester éventuellement en affectant préalablement des valeurs aux variables.
3. Soit Ω = (X,Y ) un point du plan, r > 0 et A = (xA, yA) un autre point. Déterminer une expression booléenne

dépendant des variables X, Y, xA, yA et r permettant de tester si le point A est strictement à l’intérieur du
cercle de centre Ω et de rayon r. Tester votre condition avec les valeurs suivantes.
a. Ω = (0, 0), r = 2, A = (1, 1.5) b. Ω = (1, 3), r = 4, A = (5, 2)

4. Reprendre la question précédente pour écrire une condition if comme dans l’exemple situé plus haut, disant
si oui ou non A est à l’intérieur du cercle. Remarque : si b est un booléen, il est tout à fait valable d’écrire
if b:, alors qu’il est redondant d’écrire if b==True:. On utilisera la fonction d’affichage print, appelée avec
une chaîne de caractères comme "A est à l'intérieur du cercle".

Pour n < m deux entiers, on rappelle que range(n,m) produit un itérable, fournissant la suite des entiers de n à
m− 1. On fait parcourir à une variable i ces entiers-là à l’aide d’une boucle for ayant la forme suivante :

for i in range(n,m):
[instructions]

s=0
for i in range(1,10):

s=s+i #s contiendra la somme des entiers de 1 à 9

Les instructions indentées étant répétées pour tout i entre n et m − 1. On peut de plus spécifier un pas p : pour
p > 0, range(n,m,p) permet d’obtenir les entiers n, n+ p, n+ 2p... strictement inférieurs à m.

Exercice 3. Quelques boucles for . Vérifiez expérimentalement les formules suivantes (on coupera la somme après un
« grand » nombre de termes, comme 10000 ou 100000).

1. π2

6 =
[

1
12 + 1

22 + 1
32 + · · ·+ 1

n2 + · · ·
]

2. ln(2) =
[
1− 1

2 + 1
3 −

1
4 + · · ·+ (−1)n

n+1 + · · ·
]
(remarque : le logarithme népérien est log dans le module math).

3. π
4 =

[
1− 1

3 + 1
5 −

1
7 + · · ·+ (−1)n

2n+1 + · · ·
]

4. π
8 =

[
1

1×3 + 1
5×7 + 1

9×11 + · · ·+ 1
(4k+1)(4k+3) + · · ·

]
On rappelle le fonctionnement d’une boucle while : tant qu’une certaine condition est vérifiée, on réalise les

instructions de la boucle. Plus précisément, à chaque fois que l’expression booléenne s’évalue en True, on fait un tour
de boucle et on réévalue la condition. Dès qu’elle s’évalue en False, on passe aux instructions situées après la boucle.

while expression:
[instructions]

a=123
while a>0:

print(a) #on affiche à l'écran les quotients dans les
a=a//2 #divisions successives de 123 par 2
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Exercice 4. La conjecture de Syracuse. Pour u0 ∈ N∗, on considère la suite définie par :

un+1 =

{
3un + 1 si un est impair.
un/2 sinon.

On conjecture que pour tout u0 ∈ N∗, il existe un indice n tel que un = 1 (à partir de cet entier n, la suite prend
périodiquement les valeurs 1, 4 et 2).

— Écrire une boucle while permettant de vérifier cette conjecture pour u0 fixé. Testez-là ! Remarque : on n’a ici
besoin que d’une variable pour calculer successivement les termes de la suite, qu’on pourra appeler u.

— On appelle temps de vol à partir de u0 le plus petit n tel que un vaut 1. Calculez ce temps de vol pour u0 = 15
et u0 = 127. On affichera les valeurs de la suite obtenues avant d’atteindre 1, à l’aide de print.

6 Pour les cracks
Répondre aux questions suivantes à l’aide d’un script Python. La solution est précisée, pour que vous puissiez

vérifier que votre script fonctionne. Faîtes comme si vous n’aviez aucune idée de la solution !
— Quelle est la somme des entiers entre 0 et 10000 (tous deux inclus) qui sont divisibles par 3 ou par 5 ?

Réponse : 23341668.
— Quelle est la somme des entiers entre 0 et 10000 (tous deux inclus) qui sont divisibles par 3 ou par 5 mais pas

par 15 ? Réponse : 20010003.
— Comment se décompose 600851475143 en facteurs premiers ? Réponse : 600851475143 = 71 ×839 ×1471 ×6857.
— Quelle est la somme des chiffres de 1000! (factorielle de 1000) ? Réponse : 10539.
— Que vaut 2√

2
× 2√

2+
√
2
× 2√

2+
√

2+
√
2
× 2√

2+

√
2+
√

2+
√
2

× · · · ? (Remarque : on définit en fait une suite, vérifier

qu’elle est convergente.)Réponse : une fraction impliquant π.
— Quel nombre inférieur ou égal à 106 possède le plus grand temps de vol (défini dans l’exercice précédent) ? Il n’y

a qu’une solution. Essayez d’écrire un script qui la donne le plus vite possible. Réponse : 837799.

À préparer sur feuille pour le 17/09
Exercice 5. 1. On exécute le code suivant, donner les valeurs des variables après exécution.

a=5
b=a+2
a=b
c=a==b
a=10
d=a!=b

2. On suppose x, y et z affectées, ces variables sont des entiers. Indiquer un code permettant de tester si au moins
deux des entiers sont égaux (on affichera un message à l’écran, du style « il y en a deux égaux » ou « ils sont
tous distincts »).

3. On peut montrer que
∑n
i=0 i

3 = n2(n−1)2
4 . On suppose la variable n affectée, elle contient un entier naturel.

Écrire un code permettant de vérifier la proposition (on pourra par exemple afficher un message à l’écran du
type « la conjecture est vraie pour n »).

4. Soit n ∈ N∗. On appelle valuation 2-adique de n l’unique entier p tel que n = 2pm, avec m un entier impair.
Par exemple, la valuation 2-adique de 7 est 0, celle de 96 = 25 × 3 est 5. On suppose la variable n affectée,
écrire un code utilisant une boucle while permettant d’obtenir la valuation 2-adique de n, et de l’affecter dans
la variable p.
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